
 Microsoft Access Exercises for BTT 

We will now be looking at the database portion of Microsoft Office 2000.  Access is a DBMS which stands for 
Database Management System.  You can use Access to store and manage large collections of information.  As 
you go through this booklet, follow the instructions very carefully and answer the questions on your master 
handout.

GETTING STARTED

• Load Microsoft Access.(desktools – Microsoft Office – Access)
• Select Blank Access database.  Click ok.
• Notice the default filename in Access.  When you save a file, the file extension .accdb will automatically 

be added to the end of the filename to indicate that it is an Access file.
• Type payroll for filename.    Open the folder and find your BTT/Databases folder.  Save in here.  Click 

Create.
• This file is the Database file.    
• When you open or create a database file, you see the Table window, which is one of the objects you can 

create in Access.  Click on the Create Tab and you will see the objects we can create in Access.  There are 
Tables, Forms, Reports and Queries.

• These Objects will have their own title or name and will be stored in the Database file.
• Answer questions 1 to 3 on your master handout.

THE SETUP OF A DATABASE

To illustrate the following terms, an example using Ontario phone directories will be used.

• A database is a collection of related files. (ie.  all telephone directories in Ontario)
• A file is a collection of related records. (ie.  one of the phone directories)
• A record is a collection of related fields.  (ie. one persons Name, Address, Phone#) 
• A field is a specific category of information. (ie.  all the Names or Phone#’s)
• Answer question 4 on your master handout.

CREATING A TABLE

• Tables allow you to enter field names and data.  The table will then store this information. You can have 
one or more tables in a database.

Create a Table by Entering Data
• Your Database should already be open on a new table, if not go to the Create TAB and select Table.
• This is called Datasheet view for the table.  Notice that the screen looks a lot like a spreadsheet, but 

instead of letters there are Field Names for headings.  
• If it asks you to save or name the table, type in PayrollTable.
• Before you create a database, you must decide which fields you want to include in each table.  Consider 

what information the database will store and how the information will be used.  Check each field to see 
whether it should be split into additional fields based on how you need to sort, calculate, or find 
information.
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• Double-click the column header Field1, type Last.
• Note:  It is best to use field names that are just one word.
• For Field2, type First.
• For Field3, type Hours.
• For Field4, type Rate.
• Enter the information from the table. 
• Use the Arrow key to move to the next field or Enter.  You can also click 

with your mouse.

• Note:  Access automatically saves a record when you go to another record.
• Notice there is an ID column.  This is your primary key, which is a field that contains a unique value for 

each record in a table, such as social insurance number, employee number, or natural number.  This is 
important if you want to combine tables.

• Last is called a Field Name, and the name Smith is called a Field Content.

Working with Records and Fields
• In Datasheet view for a table, you can select a record by clicking the area to the left of the record or a field 

by clicking the field name.  To select all the records in a file, click the blank area to the left of the field 
names.  Once selected, these can be cut, copied, or deleted.

• Click on the cell containing the first name Dan.  
• From the Fields & Columns Dialogue Box find the Insert.  
• Notice where the column went relative to the first name 

field.
• From the same location, select the Delete Column option.  

Click Yes.
• You can also change the order of fields by selecting the 

field you want to move, then use the mouse to grab and drag the field name to the new location.  A 
vertical black line indicates where the new column will go.
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Last First Hours Rate

Smith Dan 23 12.80

Barnes Jim 10 10.50

Haines Mary 40 19.95

Mills Ellen 35 19.95

Flint Kerry 32 15.50

Coil John 08 10.50

Frayne Sara 15 10.50

Vail George 42 19.95

Hertle Bill 37 19.95

Scott Sally 07 10.50

Smith Jeff 12 10.50

Jones Darren 38 19.95

Reed Scott 40 19.95

Carp Ryan 07 10.50

Simms Karen 41 19.95

Fraser Doug 12 12.80

Shore Susan 15 10.50

Janes Bill 40 19.95
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Saving and Primary Key
• When finished entering records, click the close button for the table on the right side of the table title bar.
• Click Yes to save changes to the table.  
• Note:  Each Object will ask if you want to save changes before closing.  Click Yes just in case you have 

made changes since the last save.
• IF it asks for a name, type PayrollTable.  Click ok.
• The name of your table should appear in the Table section of the Database window.
• Remember, the table is not a separate file, but rather contained in the Database file.
• Answer questions 5 to 8 on your master handout.

CREATING A QUERY

• Queries allow you to do calculations and select criteria in a database.  You type in the calculation and tell 
Access what information you want to find.

Creating a Query by using a Wizard
• Select Query Wizard from the Create Tab, Other Dialogue Box.
• Select the Simple Query Wizard.
• The wizard asks you a series of questions and then sets up a query based on your answers.
• For Tables/Queries, select Table:  PayrollTable from the list.
• Click >> to add all the fields in the same order.
• Note:  You can double click the field on the left side (or >) to add fields individually.  Double-clicking the 

field on the right side (or <) removes fields individually.
• Note:  The fields will appear in the order you select them, so use this to change the order if necessary.
• Click Next.  For title, type PayrollTable Query.  Choose Open to view.  Click Finish.
• Note:  The View button in the Home Tab allows the user to choose between Datasheet view and Design 

view.
• This is called Datasheet view for the query.

Calculations
• Select the View button on the toolbar to switch to Design view for the query.
• Design view allows you to create/edit the query and Datasheet view allows you to see the results of the 

query.
• Scroll to the next empty Field cell (to the right of Rate).
• Type:   Pay:[Hours]*[Rate]
• Note:  Formulas must be typed exactly.  Pay is the field name for the new column.  The field name and 

the formula are separated by a colon, and the field names in the formula must be in square brackets.
• Press the Enter key.

Currency
• Click back in the cell you typed the formula.
• From the top toolbar, select the Properties Sheet in the Show/Hide Dialogue Box.
• Click in the blank area beside Format.
• From the drop-down list, select Currency.
• Close the Field Properties dialogue box.
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• Note:  If you initially entered your column headings in the first row, you might have to go back to the 
Table.  In Design view (click the View button), change the formatting to Number for the Rate field.

Sorting
• In the Pay field, for the Sort cell, click and select Descending.
• Select the View button on the toolbar to switch back to Datasheet view.
• Scroll across the datasheet to see the results of the query.
• There should be a Pay field with currency showing in descending order.
• Click the Close button for the query.
• Click Yes to save changes to the query.
• Answer questions 9 to 14 on your master handout.

CREATING A FORM

• Forms display boxes that clearly show you where to enter information and usually display one record at a 
time.  Forms help you view, input, edit, and print data in index-card like format.

Creating a Form by using a Wizard
• Goto Forms in the Create Tab.
• Select More Forms and choose the wizard.
• For Tables/Queries, select Query:PayrollTable Query from the list.
• Click >> to add all the fields in the same order.  Click Next.  
• Try the different layouts.
• Select Columnar.  Click Next.
• Try the different styles.
• Select Flow.  Click Next.
• For Form title, type payform.  Click Finish.
• Note:  The View button in Forms toggles between Form view and Form Design view.
• This is called Form view for the form.  You can add, edit, and format records in this view.

Fixing up the Form  
• Select the View button from the toolbar to switch to Design view for the form.
• Design view allows you to add headers and footers and change the setup of the form.
• Each item in Form Design view is called a control.  Controls include text boxes, labels, lines, rectangles, 

etc.
• Click on the Last Name entry.  Selection boxes should appear around the field content.
• Select italic (I) from the toolbar.
• Add italic to the First Name entry as well.
• Click on the Pay entry.
• Select bold (B) from the toolbar.

Adding Headers and Footers
• In the Design View menu, select the Label Control.
• Move the cursor to the header section of the Form(beside the title of the query).
• Type your name.
• Also in the Control Dialogue Box, select the Page Numbers option.
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• For Format, select Page N of M.
• For Position, select Bottom of Page [Footer].
• For Alignment, select Centre.  Click ok.
• Using mouse, grab and drag the top line of “Page Header” down to make room for a Form Header.
• Select the Label button from the Form Design toolbox.
• Click on the Form Header section of the form.  
• Type “Employee Payroll”.
• Click on the Form Footer section of the form.
• Note:  You may have to scroll down and drag some more room for the Form Footer.
• Select the label button from the Form Design toolbox.
• Type “This is a Form Footer”.
• Select the View button from the toolbar to return to Form view.
• Select the Print Preview button from the toolbar.
• Zoom in on all the pages to see the Page Header/Footer and Form Header/Footer.
• Note:  If your name, header, or footer don’t fit, resize the control in Design view.

Printing a Form    we don’t do this in class, but in case you need to know.
• From the File menu, select Print to print the form.
• For Print Range, select Pages.  
• For From, type 1.  Press the Tab key.
• For To, type 1.  Click ok.
• Note:  To print certain records only, select the record(s) you want to print, then for Print Range, choose 

Selected Record(s).
• Click the Close button to close the form.
• Click Yes to save changes to the form.
• The name of your form should appear in the Database window as part of the payroll file.
• Submit the form to your teacher.
• Answer questions 15 to 18 on your master handout.

CREATING A REPORT

• Reports are professional-looking documents that summarize and display data from the database.  You can 
perform calculations, such as averages or totals, in a report to summarize information.

Creating a Report by using a Wizard
• Go to Reports in the Create Tab.
• Select Report Wizard.
• For Tables/Queries, select Query:PayrollTable Query from the list.
• Add the fields in the following order:  Click Last (then >), First, Rate, Pay.  Click Next.
• For Grouping, select Rate, then >.  Click Next.
• For sort 1, select Last from the list and click the Ascending sort button to switch to Descending order.
• For sort 2, select First from the list.
• Note:  The Summary Options button is available when fields are grouped and at least one of the fields is 

numeric.
• Click Summary Options.  Select Avg, Min, and Max Pay.  Click ok.  Click Next.
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• This summary adds an average, minimum, and maximum pay for each Rate.
• For Layout, select Stepped.
• For Orientation, select Portrait.  Click Next.
• For Style, select Metro.  Click Next.
• For report title, type June Payroll.  Click Finish.
• A preview of the report will appear.  Click to zoom in.
• Close the preview.

 
Printing a Report  again we don’t do this in our class
• Select Preview from the Office Button.
• If the file fits on one page, select Print from the File menu.
• If the file doesn’t fit on one page, select Page Setup from the File menu.
• Change the Top and Bottom margins to 0.5.  Click ok.
• Preview the file to make sure it fits on one page.
• From the File menu, select Print.
• Click the close button for the report.  Click Yes to save changes.
• Submit the report to your teacher.
• Answer questions 19 to 21 on your master handout.

SELECTING RECORDS      

Selecting Criteria in a Query

• Select Queries Wizard from the Create Tab.  Choose simple Query Wizard.
• For Tables/Queries, select Query:PayrollTable from the list.
• Click >> to add all the fields in the same order.  Click Next.
• Select the Modify Query Design button.  Click Finish.
•  For the Hours field, in the Criteria row, type >=35.  
• Note:  To select exact matches, such as 40 hours, type =40 for criteria.  To make a selection using not 

equal to, use <>.  
• Press the Enter key.
• Note:  After you type the criteria, press the Enter or Tab key to see if Access accepts the entry.  Access 

may change the entry to include characters it needs to apply the criteria.
• Select the View button from the toolbar to return to Datasheet view.
• Now you should just have the people that have worked 35 or more hours.
• Select the View button from the toolbar to return to Design view.
• For the Last field, in the Criteria row, type <“M”
• Note:  Field contents with text require quotes.  To select an exact match with text, such as a first name 

Bill, type =“Bill” for criteria.  Press the Enter key.  
• Select the View button from the toolbar to return to Datasheet view.
• Now you should just have the people that work 35 or more hours and whose last name begins with A to L.
• Close the query.  Click Yes to save the changes.  Save as “FullQuery.”

Print a Report with the Criteria
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• Select Reports Wizard from the Create Tab.
• For Tables/Queries, select Query:FullQuery from the list.(if you weren’t able to save as this, just choose 

the name the program saved it as for you.)
• Add all the fields in the same order.  Click Next.
• There will be no grouping for this report.  Click Next.
• For sort 1, select Rate from the list and click the Ascending sort button to switch to Descending order.
• For sort 2, select Last from the list.  Click Next.
• For Layout, select Justified.  Click Next.
• For Style, select Technic.  Click Next.
• For report title, type “Full Time Employees  Last Name A to L”.  Click Finish.
• A preview of the report will appear.  Click to zoom in so the whole page appears.  Look for the next page.
• Close the preview.
• Select the Label button from the Toolbox.
• Click below the title, type your name.
• Preview the file to make sure your name appears.
• Answer questions 22 to 25 on your master handout.
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